Searching in Concordance
Basic, Advanced, Full Text, and Relational Search Tips

Document Overview
- Overview
- Basic Search
- Advanced Search
- Full Text vs. Relational Searching
- Full Text Search Operators
- Relational Search Operators
- Keyboard Shortcuts for Searching
- Additional Resources
Concordance® 2007 Quick Help

Copyright © 2007 Concordance. All rights reserved.

LexisNexis and the Knowledge Burst logo are registered trademarks of Reed Elsevier Properties Inc., used under license. Concordance is a registered trademark and FYI is a trademark of Applied Discovery, Inc. Other products or services may be trademarks or registered trademarks of their respective companies.

Concordance®
Concordance® Image
Concordance® FYI™
Searching in Concordance

Overview

The ability to quickly organize and search discovery information is a key factor in winning your case. By utilizing the powerful search engine in Concordance 2007 you can find facts fast and organize them with precision. The following tips are designed to have you searching like a pro in no time. We’ll start with a simple word search and build from there. To get started, click the Search navigation button to open the Concordance Search task pane.

Simple Search

The Simple Search panel allows you to perform straightforward searches on the full text of the database.

- Enter your search terms in the appropriate boxes, and then click the Search button.
- Search results will appear in the Browse and Table views. In the Browse view the terms searched will be highlighted.
- Navigate from one highlighted term to the next by clicking Next Hit or Previous Hit from the Browse tool bar.
**Find a Word or Phrase**

*To search on a word, number, or phrase*

1. Type a word, number, or phrase (i.e. search term) into the Simple Search task pane.

   ![Simple Search task pane](image1)

   *Figure 1: Simple Search task pane*

2. Click the **Search** button.

3. To view the corresponding documents, click the **Browse** or **Table** button.

**Find a Word or Phrase within a Field**

Often you’ll want to narrow your search to a specific field, such as the word *correspondence* in the DOCTYPE field.

*To search for a word or phrase within a field*

1. Type your search term, a period, the name of the field you wish to search, and another period into the Quick Search Bar.

   ![Quick Search Bar](image2)

   *Figure 2: Quick Search for term in a document type field*

2. Click the green arrow button to start the search.

3. To view the corresponding documents, click the **Browse** or **Table** button.
NOTE – The total number of records in the search results may be less than the term’s search results. A search term’s results show all of the occurrences of the word within the database, and the search total shows the number of occurrences that are in the Doctype field.

TIP! – Form Search. The Form Search dialog allows you to build advanced search queries using a simple fill-in-the-blank format. If you need to quickly build a search, but don’t have time to learn the syntax, the Form Search dialog is for you. To open the Form Search dialog, simply press F4 on your keyboard.

Find Documents with a Specific Date
Part of building a strong case is having the ability to pinpoint who said what and when.

To look for a document written on a specific date
1 In the Quick Search Bar, type the name of the date field, a space, an equal sign (=), a space, and the date of the document.

![Figure 3: Quick Search for a specific date in the Date field](image)

2 Click the green arrow button to start the search.
3 To view the corresponding documents, click the Browse or Table button.

Advanced Search
Create more complex searches in the Advanced Search panel using the Concordance search language.

- Enter your search criteria, and then click the Search button to execute the search.
- Statistical results for the search will be displayed under Results.
- The Browse and Table views will display the document records resulting from your search.

Putting It All Together
Now that you’ve mastered the basics, it’s time to try a more complex search. Concordance supports very complex searches, allowing you to fine tune your search results and find the “needle in a haystack.” In this example, we’re looking for all of the Correspondence documents dated 10/14/1983 that include the word Finance.
To create an advanced search query

1 In the Advanced Search task pane, type this example search query for the Cowco database:

FINANCE AND CORRESPONDENCE.DOCTYPE. AND DATE = 10/14/1983

Figure 4: Advanced Search task pane

2 Click Search.

Your search results will appear in the Results area of the Advanced Search task pane. (Your actual search results may vary from this example). Congratulations, you’ve found your needle in a haystack!

Fuzzy Searching

Errors in spelling can cause you to omit crucial documents from your search results. Fuzzy searching allows you to find misspellings and variations in your search terms.

To perform a fuzzy search

1 In the Advanced Search task pane, enter a word and then click the Display a list of words that sound like the selected word link.

Figure 5: Fuzzy Search dialog
Concordance will look for words that sound like or are spelled like the word you have highlighted. It then displays a list of possible matches in the **Fuzzy Search** dialog.

2 Select words from the list by highlighting them with the mouse. You can select a range of adjacent words by holding the **Shift** key, or multiple non-adjacent words by holding the **Control** key, while you click with the left mouse button.

3 Click the **Ok** button in the **Fuzzy Search** window to add all of the selected words to your current search.

4 Click the **Search** button to start the search.

### Wildcard Searching

Wildcards are special characters used to replace one or more other characters in a search term. In Concordance, the asterisk (*) is a wildcard that can be used to replace the beginning or end of a search term.

**Examples**

- Searching for ***DENCE** would return the words **CORRESPONDENCE**, **EVIDENCE**, and **INDEPENDENCE**.
- Searching for **FINANC*” would return **FINANCE**, **FINANCIAL**, and **FINANCING**, etc.

Wildcard searching is especially helpful in locating variations of a particular word, without the need for repetitive entry in the **Advanced Search** task pane.

### Full Text vs. Relational Searching

There are two types of searches available in Concordance: **Full Text** and **Relational**.

**Full Text** Search – Full text searches uses a searchable dictionary of every unique word located within a database, resulting in lightning fast searching, even for the largest databases. A full text search will return results for all indexed fields, so you don’t need to specify a field unless you want to limit your search.
You can search for individual words or word combinations, words in contextual relationships (such as near each other), words in specific fields, for Boolean relationships between words, and much more.

**Relational Search** – Relational searches allows you to locate documents in the database by using a comparison search. It works best with numeric, date, and text field types. Relational searching also works on full text paragraph fields, but only searches the first 60 characters of the field.

Relational searching does not use the database dictionary, so it does not require an indexed database. It will work on any field as soon as a document is entered into the database. Because relational searching has to look at the database, it takes longer to search the database than a full text search.

**TIP! – Multiple Term Search**. You can perform a relational search for several terms at once by separating them with commas (if your search term has a comma in it, add quotes).

*Example:* AREACODE = 213, 818, 310, 714

**Full Text Search Operators**

Concordance supports several search operators, which are words that have special meaning in Concordance searches. Typically, these words define the relationship between search words or between a word and a field.

**Examples**

- The **AND** operator in the search DOG AND CAT indicates that both the word DOG and the word CAT must be present in a document in order to meet the search criteria.
- A similar search, DOG OR CAT, indicates that a document may contain the word DOG, the word CAT, or both DOG and CAT, and still meet the criteria.

There are ten full text search operators are available in Concordance (see table below). They can be broken down into three classes: Boolean, context, and proximity search operators.

**Boolean Operators**

The basic building block of the Concordance search is the Boolean operator. Boolean operators are found in just about every database program and Internet search engine, and allow you to build detailed searches using a few simple logical expressions.

<table>
<thead>
<tr>
<th>Boolean Operators</th>
<th>Syntax</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>DOG AND CAT</td>
<td>Locates all documents that contain both DOG and CAT, anywhere in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>same document.</td>
</tr>
<tr>
<td>OR</td>
<td>DOG OR CAT</td>
<td>Locates all documents that contain either DOG or CAT, or both DOG and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CAT. This is the inclusive OR operator.</td>
</tr>
<tr>
<td>NOT</td>
<td>DOG NOT CAT</td>
<td>Locates all documents that contain DOG but not CAT.</td>
</tr>
<tr>
<td>XOR</td>
<td>DOG XOR CAT</td>
<td>Locates all documents that contain either DOG or CAT, but not both DOG</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and CAT. This is the exclusive OR operator.</td>
</tr>
</tbody>
</table>
Context Operators

Context operators are similar to Boolean operators, but they work at a field level, rather than at the document level.

<table>
<thead>
<tr>
<th>Context Operators</th>
<th>Syntax</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAME</td>
<td>DOG SAME CAT</td>
<td>Locates all documents where both DOG and CAT are found together in the same field. If both words occur in the same document, but not the same field, the document is ignored.</td>
</tr>
<tr>
<td>NOTSAME</td>
<td>DOG NOTSAME CAT</td>
<td>Locates documents where DOG and CAT are found together in the same document, but not the same field. If they occur in the same document and the same field, the document is ignored.</td>
</tr>
<tr>
<td>Field Limiter (&quot;.&quot; )</td>
<td>DOG.AUTHOR.</td>
<td>Locates documents where DOG occurs in the AUTHOR field. These documents could have the search word in other fields, but those occurrences would not be located or highlighted. Several fields can be placed between the periods, if they are separated by commas: DOG.TITLE, SUMMARY, SYNOPIS.</td>
</tr>
<tr>
<td>Not-Field Limiter (&quot;.&quot; )</td>
<td>DOG..TITLE.</td>
<td>Locates documents where DOG occurs in a document, in fields other than the title field. The retrieved documents are guaranteed to contain the search term somewhere in their text outside of the specified paragraph field. If the retrieved documents contain the search term in the specified field, it will not be highlighted. The not limit operator follows the search word with two periods, the field name to exclude, and a single period.</td>
</tr>
</tbody>
</table>

Proximity Operators

The most specific of the full text search operators is the proximity operator, which works at the word level. Proximity searches always require that the words occur in the same field.

<table>
<thead>
<tr>
<th>Proximity Operators</th>
<th>Syntax</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADJ</td>
<td>DOG ADJ CAT</td>
<td>Locates documents where DOG and CAT are immediately next to each other, and in the order given.</td>
</tr>
<tr>
<td>ADJ1 – ADJ255</td>
<td>DOG ADJ12 CAT</td>
<td>Locates documents that contain DOG within 12 words of CAT in the order given. Use any number from ADJ1 through ADJ255. Note: There is no space between the ADJ operator and the number.</td>
</tr>
<tr>
<td>NEAR</td>
<td>DOG NEAR CAT</td>
<td>Locates documents where DOG and CAT are immediately next to each other, in any order.</td>
</tr>
<tr>
<td>NEAR1 – NEAR255</td>
<td>DOG NEAR20 CAT</td>
<td>Locates documents that contain DOG within 20 words of CAT, in any order. NEAR and NEAR1 through NEAR255 are all valid search operators.</td>
</tr>
</tbody>
</table>

**TIP! – Default Search Operator.** In Concordance, ADJ 0 is the default search operator. If you enter the search DOG CAT, Concordance will process the search as if you had entered DOG ADJ CAT. You can change this default to another full text search operator in the **Searching** tab under **Tools > Preferences**.

You can also change the range of ADJ searching from 0 to 2. Now, by default, if Jim Smith also appears in the database as Jim P. Smith you will find both in your search results.
Relational Search Operators

There are also ten relational search operators available in Concordance. These operators compare your search criteria with the contents of the fixed field specified in your search query. Some of the relational operators have an equivalent symbol, such as “EQ” and “=”, both of which mean “equal to.” Below is a list of the ten relational search operators.

<table>
<thead>
<tr>
<th>Proximity Operators</th>
<th>Operator</th>
<th>Symbol</th>
<th>Syntax</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>LT</td>
<td>&lt;</td>
<td>BEGBATES LT AA102000</td>
<td>LESS THAN – Locates documents where the value of the BEGBATES field is less than AA102000. This search would return documents with a BEGBATES of AA101999, but not AA102000, AA102001 or AB000001.</td>
<td></td>
</tr>
<tr>
<td>LE</td>
<td>&lt;=</td>
<td>BEGBATES &lt;= AA102000</td>
<td>LESS THAN OR EQUAL TO – Locates documents where the value of the BEGBATES field is less than or equal to AA102000. This search would return documents with a BEGBATES of AA101999 or AA102000, but not AA102001 or AB000001.</td>
<td></td>
</tr>
<tr>
<td>EQ</td>
<td>=</td>
<td>BEGBATES = AA102000</td>
<td>EQUAL TO – Locates documents where the value of the BEGBATES field is equal to AA102000. This search would return documents with a BEGBATES of AA102000, but not AA101999, AA102001 or AB102000.</td>
<td></td>
</tr>
<tr>
<td>GT</td>
<td>&gt;</td>
<td>BEGBATES GT AA102000</td>
<td>GREATER THAN – Locates documents where the value of the BEGBATES field is greater than 102000. This search would return documents with a BEGBATES of AA102001 or AB000001 but not AA101999 or AA102000.</td>
<td></td>
</tr>
<tr>
<td>GE</td>
<td>&gt;=</td>
<td>BEGBATES &gt;= AA102000</td>
<td>GREATER THAN OR EQUAL TO – Locates documents where the value of the BEGBATES field is greater than or equal to A102000. This search would return documents with a BEGBATES of AA102001 or AB000001 but not AA101999.</td>
<td></td>
</tr>
<tr>
<td>NE</td>
<td>&lt;&gt;</td>
<td>BEGBATES &lt;&gt; AA102000</td>
<td>NOT EQUAL TO – Locates documents where the value of the BEGBATES field is not equal to AA102000. This search would return documents with a BEGBATES of AA101999, AA102001 or AB000001 but not AA102000.</td>
<td></td>
</tr>
<tr>
<td>CO</td>
<td>$</td>
<td>BEGBATES $ DOG</td>
<td>CONTAINS – Locates documents where DOG occurs in the BEGBATES field. This is similar to a field limiter search, but does not require an indexed field.</td>
<td></td>
</tr>
<tr>
<td>NC</td>
<td>!</td>
<td>BEGBATES NC DOG</td>
<td>DOES NOT CONTAIN – Locates documents where DOG does not occur in the BEGBATES field.</td>
<td></td>
</tr>
<tr>
<td>WL</td>
<td></td>
<td>BEGBATES WL AA102000, AA102100</td>
<td>WITHIN LIMITS – Locates the range of documents where the value of the BEGBATES field is between AA102000 and AA102100. This search would return documents with a BEGBATES of AA102000, AA102001, AA102099 and AA102100. It would not return documents with a BEGBATES of AA101999 or AA102001.</td>
<td></td>
</tr>
<tr>
<td>OL</td>
<td></td>
<td>BEGBATES OL AA102000, AA102100</td>
<td>OUTSIDE OF LIMITS – Locates documents where the value of the BEGBATES field is outside of the range AA102000 - AA102100. This search would return documents with a BEGBATES of AA101999 or AB102001, but it would not return documents with a BEGBATES of AA102000, AA102001, A102099 or AA102100.</td>
<td></td>
</tr>
</tbody>
</table>
TIP! – Searching for Embedded Punctuation. Concordance treats most punctuation as if it were a space. For example, “AT&T” would appear as the separate words “AT” and “T” in the dictionary. In order to search on words containing embedded punctuation, the punctuation characters must be added to the Punctuation List. Select File > Modify from the Concordance menu bar. You will see the default list of punctuation characters that are included in the database index. Add the “&” symbol to the list. Other popular symbols include @, $, %, etc. After modifying the punctuation list, you will need to run File > Index to rebuild the dictionary files. This will allow you to search and retrieve terms with embedded symbols.

Keyboard Shortcuts – Searching
Use these quick keyboard shortcut keys to perform common Search commands.

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut Key(s)</th>
<th>Command or Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Search" /></td>
<td>F2</td>
<td>Search Button</td>
</tr>
<tr>
<td><img src="image2" alt="Review" /></td>
<td>F3</td>
<td>Search Review</td>
</tr>
<tr>
<td><img src="image3" alt="Form Search" /></td>
<td>F4</td>
<td>Form Search (Query by Example)</td>
</tr>
<tr>
<td><img src="image4" alt="Search" /></td>
<td>Enter</td>
<td>Execute Simple or Advanced Search</td>
</tr>
<tr>
<td><img src="image5" alt="Search" /></td>
<td>Enter</td>
<td>Execute Quick Search</td>
</tr>
<tr>
<td><img src="image6" alt="Esc" /></td>
<td>Esc</td>
<td>Cancel Search in Progress</td>
</tr>
</tbody>
</table>

Additional Resources

General Product Information
http://law.lexisnexis.com/concordance

Concordance Technical Support
Phone: 866-495-2397
Email: concordancesupport@lexisnexis.com

Concordance Training
Phone: 425-463-3503
Email: concordancetraining@lexisnexis.com